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GUIA RAPIDO DE PROGRAMACAO DOS CLP’S
LINHAS XC100/200/600

INTRODUCAO

No mercado pode-se encontrar uma variedade de diferentes linguagens e sistemas de programagdo. Para cada tipo de
linguagem sdo necessarios dispendiosos treinamentos para todos os tipos de controladores, tanto para a linguagem de
programagdo como para o sistema operacional.

O usudrio ndo consegue trocar unidades de programas entre diferentes sistemas, porque as linguagens de
programacao ndo sdo compativeis entre si.

Nao ¢ possivel a reutilizagdo de fungdes programadas sem que seja necessaria uma reprogramagao, pois o modelo de
dados destes CLP’s necessita de enderegos fisicos.

Pelo exposto acima a utilizagdo de um controlador de outro fabricante ndo era viavel por causa do alto custo.

O principal objetivo da IEC1131.3 ¢ reduzir, se ndo eliminar, todos os problemas citados acima, criando uma
estruturagdo e forma de programagdo padrao, de tal forma que o usuario ndo se torne dependente do fabricante.
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CAPITULO 1

REQUISITOS E OBJETIVOS

Antes de programar é necessario um conhecimento basico da linha de controladores l6gicos programaveis da Moeller.
Este manual de programacao rapida destina-se a auxiliar o usudrio a iniciar-se na programagdo do Software XSOFT
Versdo 2.2.5 em ambiente para Windows.

CAPITULO 2

INICIANDO O SOFTWARE

Através do menu INICIAR (START), faga a chamada do XSOFT.

", XSoft - (Untitled)* 5]
File Edit Project |nzert Eatraz  Online ‘Window Help ‘\

2|=6| S@lAaIEH o

=10
ORGANIZADOR
AREA DE
TRABALHO
PROGRAMAS
TIPOS DE DADOS
VISUALIZADOR
RECURSOS

. V_V
PDUSI.T= Drata typesIVisualizationsl % Hesourcesl
[ [GNLNE [0% [READ
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ORGANIZADOR - ¢ usado para gerenciar os novos itens de cada pasta. Através dele inserimos novos elementos nas pastas
localizadas abaixo e solicitamos a visualizagdo/edi¢do de alguns itens.

ORGANIZADOR / PROGRAMAS - Nesta pasta alocamos os programas do CLP, bem como suas fungdes e seus
blocos de fungao.

ORGANIZADOR / TIPOS DE DADOS - Aqui nds colocamos nossos tipos de dados , Structures, Enumeration,
etc...Sdo tipos de dados criados pelo usuario conforme a [IEC 61131-3

ORGANIZADOR / VISUALIZADOR - Dentre os recursos oferecidos pelo Xsoft, esta a criagdo de telas para
visualizagdo do programa criado, tanto on-line como off-line (modo simulagdo) , estas telas s@o criadas e gerenciadas nesta
pasta.

ORGANIZADOR / RECURSOS - Pasta responsavel por varios itens no Xsoft. Entre eles: Configuragio de
hardware, configurac¢do do sistema da CPU, criagdo de variaveis de rede, geragdo de graficos de tendéncia, criagdo de tabelas
de monitorag¢do etc...

AREA DE TRABALHO - Quando selecionamos ou criamos algo em qualquer pasta do organizador, este item aparece na
area de trabalho para edigdo ou visualizag@o.

BARRA DE FERRAMENTAS — Aqui ficam algumas ferramentas para acesso mais rapido a algumas fung¢des do programa,
esta barra muda conforme o item selecionado na Area de Trabalho.

MENU PRINCIPAL — Aqui ficam todas as op¢des de acessibilidade e funcionamento do XSOFT.

Os passos necessarios para a criacdo de um programa sao:

e  Criar um novo projeto
e Configurar o Hardware
e  Criar os arquivos fontes necessarios (POU)
e  C(Criar as Variaveis
e Realizar a logica do programa
e  Criar blocos de fungdo e /ou fungdes.
e Compilar o programa
e Realizar os testes
o Configurar as telas / ferramentas de visualizagdo.
e  Executar os testes do programa em modo OFF-line.
e Realizar o comissionamento da maquina.
e  Transferir o programa para o CLP
e  Executar os testes do programa em modo ON-line
e Armazenar os programas fontes no CLP. (Quando desejado)
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CAPITULO 3

INICIANDO UM NOVO PROJETO

Entre no menu principal op¢do FILE - NEW , ou selecione o icone El . Isto ira abrir a seguinte tela:

Target Settings Ed

LConfiguration: Maone hd kK I Cancel |

Selegdo do tipo de CPU

No item Configuration selecione a CPU que ird utilizar para este programa, por exemplo:

arget Settings x

Configuration:

Target Platharm | Memary Layout I General I Wetwarkfunctionality |

Bl attorm IInfineon 16w j
~ Code —DPP  Libraries
Stacksize [ER [Cade Tjakles
|22 =l | [Mane ]| | [res0 EZ
[ata FElnetions R . I,
Huge j IHuge j INDn'3 j 3ta ateeng
bires f1680 [1650
INone j
~ Dutput Bl Eeferentes
s | ner E E
I | LT with &dHresses

Default | ak I Cancel

Ao selecionarmos a XC-CPU101-C64K-8DI-6DO escolhemos uma CPU do modelo XC100. Com isto a tela do
Target Settings , e 0 XSOFT, se modela para podermos configurar este tipo de CPU.

O usudrio ndo tera acesso aos itens: Target Plataform, Memory Layout e General. Estes itens s6 sdo configuraveis em
outros modelos de CPU. O item Networkfunctionality , serve para configurarmos a rede deste equipamento, este
topico sera abordado em outras documentagoes.

Ao selecionarmos a CPU que desejamos utilizar, pressionamos OK.

Mew POU E

Nome do
Name of the new POL: [PLC_PRG <« | Pou
Type of the POU——————— [~ Language of the POU Cancel |
% Program (o[
™ Function Block LD
" Function " FBD
Beturn Type: I SFC <
Tipo do oo ||| s \\ Linguagem do
POU I CFC POU
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e Na opcao Tipo do POU selecionamos se queremos criar um programa, um Function Block ou uma func¢ao.

Fungoes sdo elementos de software, que podem ser utilizados varias vezes dentro de um mesmo programa, de tal forma que,
quando executados com um certo conjunto de valores de entrada, sempre produzem um unico valor como resultado.

Blocos de fun¢des sdo uma categoria da Unidade de Organizag¢do de Programa (POU). Que permitem um algoritmo
especifico, ou conjunto de agoes, que podem ser chamados em varias instancias dentro de um mesmo programa, de tal forma
que, a serem aplicados em um conjunto de dados de entrada eles produzem um novo conjunto de dados de saida.

e No nosso caso iremos selecionar a opgao Program, pois iremos criar primeiro um programa.

e Na opcao nome do POU deixamos PLC_PRG , este nome designa o programa principal. Para os CLPs da linha
XC100 e XC200, devemos ter sempre um programa principal com este nome, pois o compilador sabe que € por este
programa que o equipamento ird comegar a execugao.

e Na linguagem podemos escolher entre seis linguagens de programacao diferentes. Estas linguagens se dividem da
seguinte forma:

CONFORME REPRESENTACA ~
IEC 6 11313 0 NOMENCLATURA ABREVIACAO
Instruction List (Lista de instru¢des) IL
Textual Structured Text (Estruturada) ST
Normalizada Function Block Diagram (Blocos Logicos) FBD
Grafica Ladder Diagram (Ladder / Logica Rel€) LD
Sequential Function Chart (Diagrama sequencial) SFC
Nao Normalizada Grafica Continuos Flow Chart editor (CFC) CFC

e  Para este guia rapido estaremos trabalhando com a linguagem em Ladder (LD).

e Assim que pressionarmos OK na tela New program estaremos dentro do ambiente Xsoft.

. Agora noés precisamos configurar o hardware do CLP. Para isto selecione no organizador a pasta resources:
Recursos

E- CI Global %/ ariables Variaveis Globais

e | library Counter. ib*9.1.03 13:12:26: global variables Bibliotecas
B
B

-] library RTCLIb.ib*4.9.02 10:06:00: global wariables  Bibliotecas
-] library Standard.ib*7 6.02 08:26:00: global variables Bibliotecas

""" PLLC - Browser Browser

""" PLC Configuration Configurador

----- Sampling Trace Ferramenta de Visualiza¢do (TRACE)
""" A Target Settings Configuracdo da CPU

..... Task configuration Gerenciador de Tarefas

..... &4, Watch- and Receipt Manager Ferramenta de visualizagao

¢ Selecione a op¢do PLC-Configuration. Nesta tela estaremos configurando o Hardware do CLP.

- .Kum’guratlun HC-CPIM M -CEAk-8DI1-600 =
&[] AT %IB0: BYTE; (* Local Inputs =) [CHANNEL ()] Settings | Dther Parameters | > —
- g [T : . arametrizagao
Topologia do | ¥ AT %QB0: BYTE; " Local Outputs ™) [CHANNEL (31)]

......... EMPTY-SLOT[SLOT)]
--------- EMPTY-SLOT[SLOT]
--------- EMPTY-SLOT[SLOT]
--------- EMPTY-SLOT[SLOT]
--------- EMPTY-5SLOT[SLOT]
--------- EMPTY-SLOT[SLOT]
--------- EMPTY-SLOT[SLOT]

equipamento

¥
Check for overlapping addresses: W
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e Para adicionar mais placas selecione um dos EMPTY-SLOT com o botdo direito do mouse, logo em seguida escolha
a opcao Replace Element:.

B Konﬂguration HC-CPIUM01-CR4K-8D1-600 ﬂ
[EI . AT %IB0: BYTE; ¢* Local Inputs *) [Ch
B . AT %GB0 BYTE; (* Local Qutputs *) [
Lk EMPW o I{r:;;rt Element
' EMFTY-SLO SppendlSubelement |
EMPTY-5L0 " EMPTY-5LOT
EMPTY-SLO Compute addreszes #IOC-800

— @ EMPTY-SLO Cu — HKIOCAEDO-5

EMPTY-SL0 XIOC-16D0O
Eopy trE sioc1zpoA

EMPTY-SLOS Easie Cls/ SI0C-240-01-24042
[elete [irel Sl0C-440-U1

%I0C-440-U2
I0C-240-U2
SI0C-EDI
SI0C-1EDI
XIDC1EDIAC
s0C-81-U1
S0C-G41-U2
DTG 2
SOC-AT-PT
I0C-1CNT-100kHz
%0C-2CNT-100kHz
Module Type 1/0

e Nesta tela escolhemos qual o modulo local que sera colocado com a CPU, no caso do XC100 podemos colocar até 7
mddulos locais ao lado da CPU.

e Para este exemplo selecione o modulo XIOC-16-DI.
e  Coloque mais um moédulo XIOC-16-DO-S ao lado.
SR -Knnfguratlnn HC-CPIUM M -CE4K-BD1-6D0

[]. AT %IB0: BYTE; (* Local Inputs *) [CHAMMEL (3]

& ! i,| AT %QB0: BYTE, (* Local Outputs *) [CHANNEL (Q)]
~[§ HIOC-1BDISLOT)

MI0C-1600-8[5L0T]

......... EMPTY-SLOTSLOT]

--------- EMPTY-SLOT[SLOT]

--------- EMPTY-SLOT[SLOT]

--------- EMPTY-SLOT[SLOT]

--------- EMPTY-SLOT[SLOT]

]
=

,_|
=
a

e Pressione com o botdo esquerdo do mouse o simbolo + que aparece do lado esquerdo do XIOC-16DI.
-~ HI0C-16DISLOT]

AT BIAZWORD, (716 Inputs =) [CHANMEL (1)]

e Selecione novamente o simbolb + que aparece do lado esquerdo do AT %IW2 : WORD ;
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Endereco WORD desta
placa

RIOC-16DI[SLOT]

B %] AT %IW2: WORD; (* 16 Inputs *) [CHANMEL ()]
--------- AT %0%2.0: BOOL: {* Bit 0%
- [Y] AT %1K2.1: BOOL; (" Bit1 %)
AT %1%2.2: BOOL; (* Bit 2%
-] AT %1%2.3: BOOL; 7 Bt 37
AT %I%2.4: BOOL; (* Bit 4 )
-] AT %I%2.5: BOOL; (" Bit 5 %)
AT %0426 BOOL: (* Bit6
AT %[%2.7: BOOL; (* Bit 7*)
AT %1%3.0: BOOL; (* Bit 0 %)
AT %0%3.1: BOOL; (* Bit1 %)
AT %0%3.2: BOOL: {* Bit 2%
AT %1%3.3: BOOL, (Bit 3%
AT %1334 BOOL; (* Bit 4 )
AT %0435 BOOL: (*Bit 5
. AT %I1%3.6: BOOL; (* Bit6 )
--------- AT %[%3.7: BOOL; (* Bit 7%

MOELLER

Enderecamento Bit a Bit
desta placa

e  Para maiores dados sobre varidveis consulte o anexo VARIAVEIS neste manual!

e  Abra os sub-menus das entradas e saidas que estdo incorporadas na CPU.
B fgKonfiguration XC-CPU101-CE4K-8DIED0

Eb---[%] AT %IB0: BYTE; (* Local Inputs *) [CHANNMEL (3]
--------- [ AT %l0.0:
--------- [4] AT %0x0.1:
--------- M| AT %lx0.2:
-] AT %140.3:
--------- [ AT %ix0.4:
--------- M) AT %140 5:
--------- [] AT %140.6:
--------- [ AT %Ix0.7:
E--[,] AT %GB0 BYTE; (* Local Outputs =) [CHANMEL (G)]

: AT %0X0.0: BOOL, (*Bit0%)
AT %0K0.1: BOOL,; (* Bit1 %)
--------- AT %0K0.2: BOOL, (*Bit2%)
AT %0X0.3: BOOL, (*Bit3%)
AT %0X0.4: BOOL; (*Bit4 %)
--------- AT %0X0.5: BOOL; (*Bit5 %)
AT %0X0.6: BOOL, (*Bit6%)
AT %OX0.7: BOOL; (*Bit 7%

BOOL; (*Bit0*)
BOOL; (" Bit17)
BOGL; (* Bit 2%)
BOOL; (*Bit 3%)
BOGL; (" Bit47)
BOGL; (* Bit 5%
BOOL; (*Bit§ )
BOOL; (" Bit7 )

e  Clique duas vezes com o botdo esquerdo do mouse, entre o quadrado e o AT %IX0.0 : BOOL ;

] |JeooBool et

E AT %lx0.1: BOOL, (7 Bit1*)

e Aqui escreveremos o nome da variavel, no nosso caso PartidaMotor.

e Crie as seguintes variaveis nas entradas e saidas do CLP.

Elaborado por Danilo J.P. Quintiliano
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B .Knnfguratian HC-CPIM01-CE4K-801-6D0
- . AT %IB0: BYTE; (* Local Inputs =) [CHARMEL (1]
ﬂ PartidaMotor AT %[<0.0: BOOL, " Bit 0 =)

ﬂ Faradahlotor AT %001 BOOL, FBit1 %

ﬂ AT %IX0.2: BOOL, (*Bit 2™

E AT %I140.3: BOOL, (*Bit 3™

ﬂ AT %1404 BOOL, (* Bit 4 )

E| AT %1405 BOOL, (*Bit5 ™)

AT %1406 BOOL, (*Bit6™)

3] AT %[40.7: BOOL,; (*Bit 7=

|Z—]|Z| AT %QB0: BYTE; {* Local Cutputs *) [CHARKEL (2]
. Cnntatan‘rmcmaI AT %QW0.0: BOOL; (*Bit0*)

CnntatanstreIa AT %01 BOOL; (*Bit1 =

Cnntatanriangulo AT SQX0.2: BOOL; (FRit 2%

AT %003 BOOL; (*Bit 3%

AT %00 4: BOOL; (*Bit 4 *)

AT % C0.8: BOOL, (" Bit5 =)

AT % G306 BOOL, (*Bit6 =)

AT % Q0.7 BOOL; (Bt 7 =)

e Do lado esquerdo da tela existe a opgao de inserirmos comentarios para cada uma destas variaveis.

B azizparameter |

Comment: IBit 1]

e Para cada uma das varidveis insira os seguintes comentarios.
B (gKenfiguration XC-CPU101-CE4K-8DI-6DO

B . AT %IB0: BYTE,; ¢ Lacal Inputs =) [CHAMMEL {13

. F'amdar-ncutnrAT %l<0.0: BOOL, (¥ Partir sistermna de vacuo )
--------- . ParadaMDtorAT %l=0.1: BOOL, (* Parar sistema dewacua ®)
AT %l40.2: BOCOL; *Bit 2+

- AT %0403 BOOL; ¢ Bit 3+

--------- AT %l40.4: BOCL; * Bit 4 =)

AT %405 BOCL; (* Bit5*

= AT %406 BOCL; (* Bit6 =)

--------- AT %l<0.7: BOCL, (* Bit 7T

I:—:I@ AT %0QB0: BYTE; {* Lacal Outputs =) [CHARMEL {20]

--------- ContatarPrincipal AT %0X0.0: BOOL; (* Bomba Yacua P15
--------- ContatarEstrela AT %0x0.1: BOOL, (F Bomba Wacuo E1 )

- - ContatorTriangulo AT %2x0.2: BOOL, *Bomba Yacuo T1 %)
--------- AT %0K0. 3 BOOL, (*Bit 3+

--------- AT %2X0 4 BOOL, *Bit4+)

--------- AT %005 BOOL, (*Bita™*)

--------- AT %206 BOOL, (*Bit6*)

--------- AT %0K0.7:BOOL, (*Bit 7+

e Salve agora o que foi feito indo no menu File > Save. Ou clique no icone I_I .
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CAPITULO 4

COMECANDO A PROGRAMAR
e  Agora iremos criar um programa simples para conhecermos melhor o ambiente do Xsoft. O programa a ser criado ¢é
uma partida estrela-tridangulo de uma bomba de vacuo.

e No organiser agora escolha a op¢do POUs e selecione o PLC PRG.
4 XSoft - GUIA.PRO - [PLC_PRG (PRG-LD]]

% File Edit Project |nsert Extraz  Online  Window Help

2lz(E| Bl@ledn (R &(Bl@mw [or =] o] w4

000M|PROGRAM PLC_PRG

A POUs 0002)vAR - S .
b iR pongenD_ver @ Declaracdo de variaveis locais

ORGANIZADOR e

Barra de ferramentas

E\

Linhas de Comando

AREA DO PROGRAMA

Status simulador Online/offline

| PDUSI.I: Data typesl\z"isualizat...l% Hesoulcesl

<

»
[OMLCINE [0 [READ

e Na area do programa clique sobre a linha de comando que aparece e clique no menu em Insert > Contact, ou
. . -|I-|
pressione o icone na barra de ferramentas.

e Na linha de comandos ird aparecer um contato NA : —l I_

e Clicando nas interrogagdes poderemos escrever o nome deste contato. Podemos ainda pressionar a tecla F2 de nosso
computador:
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Help Manager
ncal"u"aribles {23 Global Variables 0K I
Global Y arables E}""IGIb | ariah
Spstem Wanables n mhal vanahles Cancel |
TipO de i g ContatorE strela (BOOL)
variavel » i Contatan’r?ncipal [BOOL)
. @ ContatorTriangulo (BOOL)
i ¢ Paradabotor (BOOL)
; Variaveis
disponiveis
W Structured s
Fois - < Comentario da
artir siztemna de wacuo A :
variavel selecionada

e No tipo da variavel escolha o Global Variables. No lado das variaveis disponiveis escolha o PartidaMotor (BOOL).
0001

Panidamotar

e (Clique novamente na linha de comandos, e insira novamente um contato, este contato ird sair em série com o que ja
existe. Desta vez selecione a variavel ParadaMotor (BOOL).
0001

FParidamotar  ParadahMotar

e Clique no contato abaixo do ParadaMotor e pressione na barra de ferramentas a opgao ILl
0001

FartidaMotor  ParadaMotor
| | ] /1
[ Iffl

e Clique agora no contato abaixo do PartidaMotor e selecione na barra de ferramentas a opgao |£|

e Faca o mesmo procedimento e coloque neste contato a variavel ContatorPrincipal.
0001

Paridahiotar FParadahotar
| | | /1
11 |,/|
CaontatorPrincipal

e Clicando novamente na linha de comando, selecione agora na barra de ferramentas a opgao |i|
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e Isto ir4 inserir uma bobina de saida nesta linha logica. Utilize o mesmo procedimento para colocar o tag dela, no caso

0001

FartidamMatar Faradahlotor ContatarPrincipal

ContatarPrincipal

| /1 {4
IJ”JI L

e Com isto nés criamos a primeira linha 16gica de nosso programa. Salve as alteracdes e agora vamos inserir a proxima

linha.

e Vano menu principal e selecione INSERT = Network (After).
e Uma segunda linha ird surgir, coloque um contato NA do ContatorPrincipal como mostrado abaixo

0001
FParidatotaor Faradahotar CantatarPrincipal
| 1 ] /1 {4
11 I/I LY
ContatarPrincipal
| 1
11
ooz
ContatorPrincipal
| 1
11

e Nos iremos criar agora o Controle dos Contatores Estrela e tridangulo. Assim que o ContatorPrincipal entra, o
ContarEstrela também liga, permanece alguns segundos ¢ desliga.

e Iremos inserir entdo um temporizador para determinar o tempo que o contator estrela fica ligado.

e  Clique na linha da segunda logica com o botdo direito do mouse e selecione Function Block...

Help Manager

Idzer defined Function Bloc
Standard Programs
Ilzer defined Programs

=3 Standard Function Blacks

Em C:hArguivos de programasit oeller Softwaret=5aoftsT argetz\Moeler\Lib_CommaontStandard. ib
I:I Bistable Function Blocks

I:I Counber

Ea Timer
Do RTCFE]

TOF [FE

: TF [FE)

e Trigger

El"'m C:hvarguivos de programazioeller Software'=5oftsT argetziboeller.Lib_CPUT014RTCLib.lib
El"'m C:hArgquivos de programasitoeller Software\=SaoftsT argetziMoelerLib_CPUT01ACounter. lib

1| | [+

v Stuctured

0k

Cancel |

e Selecione na biblioteca Standard.lib o bloco de fungdo TON, deixe a opgdo Structured ativa e selecione OK
e Veja em anexos = Bibliotecas como importar demais bibliotecas.
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Um temporizador ird aparecer no meio de nossa linha ldgica.

oz

Y
TON

} | I a
277-{PT ET—

ContatarPrincipal

Vamos clicar nas interrogagdes acima do temporizador e colocar o nome do temporizador , vamos chama-lo de
TempoDesligaEstrela.

Assim que damos um nome para o temporizador, a seguinte janela ird se abrir:

Nome da variavel

Declare Variabl .
Classe ceEE anane Tipo da
C Marme 1ype variavel
ITempDDeingaEstreIa ITDN < __I
Cancel |
Sumbol it Initial % alue Address
[Globalvariables <] | |  CONSTANT
Comment; ™ BETAIN
Comentarios >
® [sto ocorre pois o assistente de declaracdo verifica que ndo ha nenhuma variavel declarada como

TempoDesligaEstrela, por causa disto, ele solicita que entremos com maiores dados sobre esta varidvel.
Deixe esta caixa de dialogos como mostrada acima.

O bloco de fungdo ira aparecer na declarag@o local de variaveis.
00 |PROGRAM PLC_FPRG

0002VAR:

non3 TempoDesligaEstrela: TOM,
O004(EMD_WAR

0oos
0oog

Deélafac;ﬁo de variaveis em FREE MODE

WAR
Mame Address Type Initial Comment

0001 {TempoDesligaEstrela TOM

Declaragao como uma tabela

A declara¢do pode aparecer destas duas formas diferentes, FREE MODE ou Tabelada. Para alternar entre estes
modos de exibigdo, clique com o botdo da direita sobre o campo da declaragdo de varidveis e selecione Declaration as
tables

Coloque uma bobina na linha logica 2, logo ap6s o temporizador e coloque o nome de ContatorAuxiliar.

A mesma tela do assistente de declarag@o se abre, porém desta vez no tipo da variavel selecione BOOL.

A segunda linha do nosso programa esta pronta, e a declaragdo de variaveis também.

Na interrogagdo que surge do lado esquerdo do nosso temporizador escrevemos o tempo desejado. Por se tratar de
uma entrada do tipo TIME, o tempo deve ser escrito da seguinte forma:

T#1D6H20M15S300MS Onde 1D significa o tempo de 1 dia

6H tempo de 6Horas

20M tempo de 20 minutos

158 tempo de 15 segundos

300MS tempo de 300Milésimos de segundos.

Para criarmos um temporizador de 3 segundos entdo escrevemos T#3S.
Nosso programa ficara deste jeito:
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VAR
Marme Address Type Initial Comiment

: : empoDesligaEstrela TOM

0002 |ContatorAuxiliar BOOL

noo1

Partidahdatar Faradamotor ContatarPrincipal

| 1 | /1 i
|| Ifl L
ContatarPrincipal
] 1
||

nooz

TempoDesligaEstrela
CantatarPrincipal ToM Cantatorduxiliar

[ P
I | IN e Q {)
T#35-PT ET—

e  Agora insira mais uma linha logica abaixo e coloque a seguinte logica:

ContatarPrincipal Cantatarduxiliar ContatarEstrela
| | | /] {

11 I/I LY

e Assim que o ContatorPrincipal ligar o ContatorEstrela ficara ligado até o tempo de 3 segundos se esgotar.

e Crie agora mais uma linha, abaixo desta, com o seguinte contato:

ContatorPrincipal

e Coloque agora um contato NA e pressione F2.
e Assim que a tela Help Manager aparecer selecione Local Variables = TempoDesligaEstrela - Q. Como mostrado
abaixo:
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Help Manager I
4 Local Varisbles akK I

Ll:u:: :I gs
Global Vaniables
System Wariables

i Contatordusiliar [EOOL)
E|"|Ij Tempol eghgak strela [TOM)
- @ ET(TIME)

Cancel

%0 (B00L)
b StartTime (TIME)

v Stuctured
I iz TRUE. PT zeconds after IM had a rising edge

e Termine esta linha, ela devera ficar desta maneira:

WAR
Mame Address Type Initial Comment
0001 |TempoDesligaEstrela TOM =
0002 | ContatorAwsidliar BOOL -
0003 [TempoLigaTriangulo TOM =
0001
Fartidamotor Paradamotar ContatarPrincipal
| | | /1 i
[ | I/I L
ContatarPrincipal
| |
[ |
ooz
TempoDesligaEstrela
ContatarPrincipal ContatorAuxiliar
TON
| | {3
[ | IN e . L}
T#ISAPT ETH—
o003
ContatarPrincipal Cantatarduxiliar CantatarEstrela
| | | /1 {3
[ | I/I L
0004
TempoLigaTriangulo
ContatarPrincipal TempoDesligaEstrela.@ TOM ContatorTriangulo
| | | | iy
[ 1 [ 1 IN e Q 1k
T#1odeT erl—

e Na quarta linha logica, no segundo contato da esquerda para direita, nds usamos o TAG TempoDesligaEstrela.Q,
poderiamos ter utilizado o proprio ContatorAuxiliar sem problemas, fizemos isto exatamente para demonstrar uma
funcionalidade a mais do programa.

e  Salve o programa, estamos prontos para a proxima etapa.
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CAPITULO 5

COMPILANDO O PROGRAMA

Para compilar o programa, entre na op¢do Project = Rebuild AlL...

Isto ira compilar todos o seu projeto. Uma tela ira aparecer abaixo de seu programa mostrando possiveis erros ocorridos no seu
programa. Para localizar o erro, clique duas vezes em cima dele e vocé ira para a linha onde este erro esta.

Para maiores informagdes sobre os erros, por favor consulte o0 manual do XSOFT, ele contém um apéndice com os principais erros.

CAPITULO 6

SIMULANDO O PROGRAMA

Para utilizar as ferramentas de simulagdo vocé deve ter o programa compilado como se vocé fosse transferi-lo para o CLP.

Habilite no menu principal a op¢gdo ON LINE - Simulation Mode...isto ira colocar o programa em modo de simulag@o.

Agora selecione a op¢do ON LINE - Login... isto fard com que o software faga um Login com um CLP virtual.

Este CLP virtual inicializa em STOP, va novamente para ON LINE - Run e estaremos com este CLP virtual em modo RUN. A
tela que aparecera ¢ a seguinte:

Variaveis ON LINE Contato Logicamente Programa Bobina Logicamente
Fechado Desligada
0001F f-- TempoDesligaEstrala J fa
0002 ContatorAizdliar = gk | |
0003 & TempoLigaTriangulo
0004 v =
' v
Pattidahiator ParadaMatar ContatarPrincipal
| I |I| L)
ContatorPrincipal
TempoDesligaEstrela
ContatarPrincipal Contatarduxiliar
TOM
] | i}
I IN ﬁ Q { )
T#I5APT ET—
ContatorPrincipal ContatorAuxiliar ContatarEstrela
_l ] l PN
I |I| L
TempoLigaTriangula
ContatorPrincipal TempoDesligaEstrela.q TON ContatarTrianguln
| ] | i}
—] | 11 IN e Q .
T#1S-{PT ET—
XSOFT MODO SIMULACAO
Contato Logicamente
Aberto XSOFT ONLINE CLP MODO RUN
4

L3
P [ONLINE I HUNﬁHEE [0 [READ

Elaborado por Danilo J.P. Quintiliano Depto. Eng. Aplicagao Pagina 15 de 33



MOELLER

e Para forgar entradas, saidas ou memorias internas podemos proceder de varias maneiras diferentes.
e D¢ um duplo clique com o botdo da esquerda do mouse sobre o tag do contato PartidaMotor, verifique que a cada
duplo clique ele muda o desenho:

FartidaMotor - Contato NA logicamente aberto

—f

Fartidabotar - Tag na cor preto, com um quadrado na parte inferior com as bordas azul claro preenchimento azul escuro.
_I.'_ Contato NA logicamente aberto, forgar ON quando do comando FORCE

Partidamotor Tag na cor preto, com um quadrado na parte inferior com as bordas azul claro sem preenchimento.
||:|| Contato NA logicamente aberto, forcar OFF quando do comando FORCE.

e  Se dermos mais um duplo clique o contato volta ao estado anterior.

e D¢ um duplo clique no Tag e deixe-o na posi¢éo forcar ON.

e  Agora pressione F7, ou va até o menu Online = Force Values. O nosso botdo de partida sera for¢cado para a situagio

ON.
Fartidahotor Observe que o TAG PartidaMotor aparece em vermelho. Ao redor da quadrado azul também aparece uma
_|I|_ linha vermelha para indicar que esta variavel esta sendo forgada.
Contato NA logicamente fechado, for¢ado.
e Repare que a indicagdo FORCE aparece no canto esquerdo da tela, para indicar que existem variaveis forgadas em

seu programa, |ONLINE' [SIM [RUN [EF [FORCE [0 [READ

e Se quisermos forcar varias varidveis ao mesmo tempo, podemos ir clicando com o mouse e deixando-as nos valores
logicos desejados, assim que pressionamos F7 os valores sdo carregados para os Tags.
e  Verifique o funcionamento do seu programa, ele deve ligar o contator principal juntamente com o estrela, contar um
tempo de 3 segundos, desligar o contator estrela, esperar mais um segundo e ligar o contator tridngulo.
e Vamos agora retirar o comando de partida, clique novamente com o botdo esquerdo do mouse sobre o TAG
PartidaMotor e verifique como ele muda o status:
Fartidamotor Contato NA logicamente fechado, for¢ado.

——

Faridahotor Tag em vermelho, aparece um quadrado na parte inferior do contato com bordas azul claro e

|H| preenchimento cinza.
Contato NA logicamente fechado e for¢ado. Liberar comando FORCE quando ocorrer novo comando

FORCE.
FaridaMotor - Tag em vermelho, aparece um quadrado na parte inferior do contato com bordas azul claro sem

_lHi_ preenchimento.
Contato NA logicamente fechado e for¢ado. Forcar estado OFF quando ocorrer novo comando FORCE.

e  Se estivéssemos ONLine com o CLP, bastaria colocarmos o comando Liberar comando Force, que o TAG assumiria
o valor da entrada digital logo em seguida.

e Como estamos com um CLP virtual, que ndo possui entradas fisicas, para desligarmos adequadamente este contato
precisamos forga-lo para a condigdo OFF e logo em seguida liberar o comando force.

e Experimente agora for¢ar o botdo de desliga. Force-o para a condicdo ON (Aberto pois ele ¢ um NF), logo em
seguida para a condi¢@o OFF e entdo libere o FORCE.

o Estas fungdes estdo disponiveis tanto no modo Simulag@o, como conectado com o CLP.

FORCANDO VARIAVEIS PELA CONFIGURACAO

e OQOutra forma de realizar esta operagdo ¢ forgar os elementos de entrada e saida.
e  No Organizador v4 em Resource > PLC Configuration
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B [Egkonfiguration XC-CPLUM 01-CE4k-8D-600

El AT %IB0: BYTE; (* Local Inputs *) [CHANMNEL (3] =
FartidamMotar AT %l<0.0: BOOL, - Bit0*)

FParadamotor AT %EX0.1: BOOL, (FBit1

| AT %02 BOOL, (*Bit2 )

-] AT %03 BOOL, (*Bit 3% Valor do BYTE em
-] ['§] AT %[0.4: BOOL, ¢* Bit 4% questio
[ AT %IX0.5 BOOL; (*Bit5#
Status das entradas / =[] 1] AT %IX0.6: BOOL; (" Bit 67
saidas - [] ] AT %IX0.7: BOOL; {* Bit 77

[—:Im AT %2B0: BYTE; i Local Qutputs =) [CHARNMEL Q)] =
|:| . ContatorPrincipal AT %QE0.0: BOOL, (FBit0 *}

|:| ContatorEstrela AT %<0 BOOL, (FBit1 %
|:| ContatorTriangulo AT %02 BOOL, (FBit2#)
-] AT %003 BOOL, (*Bit3*
-] AT %EK0.4: BOOL, (* Bit 4
] AT %005 BOOL, (*Bits™)

- AT %006 BOOL, (*Bit6™)
AT % Q0.7 BOOL, (*Bit7T*

e Para forcar a entrada PartidaMotor basta clicar uma vez com o botao esquerdo do mouse no quadrado que se encontra
a esquerda do TAG.

e Para desliga-lo € so clicar novamente neste quadrado.
e Acione agora o TAG ParadaMotor.

CRIANDO TELAS DE SIMULACAO

e  Para criar telas de simulagdo é necessario estar com o simulador parado, por isso va até a op¢do menu Online =
Logout.
e  Viaagora até o organizador e selecione a op¢do Visualizations.
e Clique com o botdo da direita do mouse sobre a pasta Visualizations e selecione a op¢do ADD Object...
e I[sto abrira a seguinte tela:
Mew Yisualization

Mame of the new Wizuahzation: || )y |
Cancel |

e D& um nome para este Objeto de Visualizacdo, por exemplo VISI.
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Seletor de Quadrado Quadrado Circulo Poligono
elementos na tela borda redonda

ZOOM da
TELA

228 1)) &

3 Visualzations T AN
i _ SRS
= coooiiiiono S/ Chamaroutra
] Y ASEEEE tela de R S
Linhacurva | /-l Visualizagio |
----| Importar RS S RS RS SR
Bitmap
Organizador
N NI Status XSoft. [
T para desenho.
Coordenadas
XY do cursor
F'DUS].T:DatatypesIVisualizationsl%Hesourcesl

A< B1LY. 599 [Element:

L. . o . . , 0K . o . .
e Primeiramente vamos criar um botdo de Partida. Clique no icone IA para criar um boto na tela de visualizag@o.
e Assim que vocé selecionar esta op¢do, clique e arraste o mouse na tela de visualizagdo para criar o botdo

e D¢ um duplo clique neste botdo para edita-lo

Elaborado por Danilo J.P. Quintiliano Depto. Eng. Aplicagao Pagina 18 de 33



MokrLer §)

Criar textos Importar Bitmap

Regular Element Configuration [#0])

Associagdo com
variaveis Categon:
Bitmap Bitmap: | ok
Test I -
‘Y ariables
Entrada de Input — |
dados Text for Toolip s
ol £+ Anizotopic
; £ |zatropi
Tooltin |satropic
" Fixed
LColar &larm colar |

e Para cada item selecionado, teremos uma caixa de didlogo diferente.

e Selecione a opgdo Text

Regular Element Configuration [#0]

]|
Texto do botdo M
Eitma Text kK. I
“arniahles LCantent: Partida Motor
. C |
Alinhamento do Irput . . il
texto ~— Text for Tooltip Harizontal
0 Left &' Center " Right
Wertical
= Top % Center " Bottam
Fonte do texto [——
\T Font... | Standard-Font |

e Escreva no texto do botdo Partida Motor. Mantenha o alinhamento central e escolha uma fonte de texto qualquer.

e Selecione agora a opg¢ao Input.

Regular Element Configuration [#0]) E3

LCategon:
- — Input
Bitmap Ok,
TE"Et [ Toogle varable I |_I
Y ariables C |
W TigVariable [ (=T |
Text for Tooltip
™ Tip FALSE

™ Zoom to vis.: I

[~ Execute program: I

™ Test input of wariable 'Textdizplay’

e Selecione a op¢do Tip Variable. Clique com o mouse dentro do quadro branco e pressione F2.
e  Assim que a tela help manager abrir selecione em Global Variables = PartidaMotor (BOOL)
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Regular Element Configuration [#0] E

Botao tipo retengdo Q@’P: Inout
~ s Eltmal:l \_ 4 =
Botao tipo PUSH ; I Toogle variable I |_I
. Y aniables C |
Inverter botdo tipo ¥ TipWariable IF'altidaM otar ance |
PUSH [Tewtforfeslip | >
Tip FALSE
Chama outra tela de L R
visualizacdo ?' Zoom bo vis.: I
Executa um /’r Execute pragram; I
programa
W Textinput of variable 'Textdizplay’
Entrada de dados pela
variavel "Textdisplay’

e Selecione agora Text for Tooltip
e Escreva em Content: Ligar a Bomba de Vacuo.
Regular Element Configuration [#0]

Categony:

Bitmap — Test for Toolip

Text : 5
Wariables LContent: |Ligar a Bomba de Wacuo

Cancel

o]
InEut |

e Pressione OK e o botdo de partida estara pronto. Vamos agora criar o botdo de parada, basta criar um outro botdo do
lado deste e configura-lo da seguinte maneira.

Regular Element Configuration [#1]
LCategary:
Bitrnay — Text o, I
“Wanables LContent: Parada botor
Input Cancel |
Text for Tooltip — Horizontal
0 Left % Center ™ Right
— Wertical
" Top ¢ Center ™ Battam
Font... Standard-Font
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Regular Element Configuration [#1)] |
LCategony:
p — Input
Bitmap oK
;E,E"ft " ™ Inoogle variable I |_I
aniables
¥ TipVarizble IF'arau:IaMu:uh:ur Cancel |

Text for Toollip
[T TipEALSE

[ Zoom to vis.: I
™ Execute prograr; I

[~ Test input of variable 'Testdizplay’

Regular Element Configuration [#1)
LCategony:
Bitmap — Test for Tooltip 0K, I
Teut
“ariables Lontent: |Desligar a Bomba de Yacuo
Cancel |

Insut

Particla Matar : Parada Matar

e D¢ um duplo clique no circulo e a tela de configuraggo desta figura ira aparecer.

Texto da figura Controle da forma
Contorno Regular Element Configuration [#2] |
Cores ................................ . Shape
Controle de £ Beotangle Cancel |
movimentos Muotion absolute R rectangle
b otion relative -
Wariables :
Variaveis [nput _ & Elipse
Text for Toaltip
Entrada de dados
Tooltip
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Na opgdo Text = Content escreva o seguinte: Bomba de Vacuo
Entre agora na opgao Color

Cor utilizada na
situacdo normal

Figura sem
preenchimento

MOELLER

Regular Element Configuration [#2]

Figura sem
FRAME

Categary:

Shape
Text
Line width

Motion absolute
Maotion relative
Wanables

Input

Text for Toaltip

— Color

ide

Em

rA; colef inzide

[ Mo frame colar

% color

Inzide

— /

Cor dentro da figura

-«

Cor do frame
da figura

—

Nesta opcdo podemos controlar as cores de nosso objeto.

Cor utilizada na
situacao alarme

Em Color escolhemos a cor natural de nosso objeto e em Alarm Color escolhemos uma cor a ser utilizada quando o

bit de alarme , que veremos mais adiante, esteja em nivel 1.

Clique em color - Inside e escolha a cor verde.
Selecione agora a op¢do Alarm color = Inside e escolha a cor vermelha.

Clique agora na opgdo Variables

Regular Element Configuration [#2]
LCategory:
Shape —Wariables K I
Text
Line width Irwisible: | &
Color Cancel | ||
Mnt!on al:usn_lute Change colar: I <
totion relative
‘W ariables :
IFput Tertdizplay: I —_
Tewt for Taoalip \

L 1 Torna o objeto invisivel

Muda a cor do objeto

—

Coloca um valor no
objeto

Pressione a tecla F2 no campo Change color.
No Help Manager selecione em Global Variables = ContatorPrincipal.
Selecione agora a opgao Text for Tooltip e escreva o seguinte: Contator Principal Bomba de Vacuo.

Crie o mesmo procedimento para os outros dois contatores como abaixo. Utilize a op¢do CTRL~+C (Copiar)e
CTRL+V (Colar) para que os circulos saiam iguais.
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Regular Element Configuration [#3] Regular Element Configuration [#4]

LCategony: LCategory:
Shape Wariable: [ ok | Shape Variables oK I
Text Test
Line wicth Ivisible: | Line width Invisible: |
Colar Cancel | Colar Cancel I
Mation absolute Change calor; IEontatorE strela Mution absolute LChange color: |E0ntatorT fiahgulo
I ation relative b ation relative
W ariablez . J anables . .
IFpLt Textdisplay: I Inpu . Textdizplay: |
Text for Toolkip Text for Toolip
Regular Element Configuration (#3]) A |l Regular Element Configuration [#4) [ <]
LCateqary: LCategon:
Shape — Test for Tooltip | oK. I ?hatpe — Text for Toaltip oF. I
Text ex - ,
Line width Content: |Contator Estrela Bomba de Vacuo Line width LContent: {Contator Triangulo Bomba de Vacuo = ;
Calor Cancel | Color ancel
Muotion abszolute mot!on ablsc_ulute
Motion relative M Dt_logl relative
‘Yariables | 3”5: =
T Er— e o Tookp |

e Nosso display ira ficar desta forma:
Partida Motor : FParada Maotar | Bormba de Yacuo X Bormba de Yacuo X Bomba de Yacuo .

e Vamos gerar um mostrador de tempo. Faga um quadrado (@I ) logo abaixo dos botdes de partida. A tela de
configuracdo ¢ idéntica a do circulo.
e Configure conforme abaixo

Regular Element Configuration [#5]

LCateqgaony:
|Shaie — Test Ok I
Line width Content; Tempo %z

Colar Cancel |
Mu:utiu:un absu:_ulute — Horizontal

hation relative ™ Left % Center " Right
Yanables = = =

Irypat —Wertical
Tt for Toolti

mrar et  Top &+ Center " Bottom

Fort.... Standard-Fomt

O XSOFT substitui a expressao %s pelo valor constante em Textdisplay. (Veja abaixo)
Selecione agora a opgdo Variables.

Coloque o cursor dentro do quadrado branco em frente a Textdisplay.
Pressione F2 e selecione PLC_PRG > TempoDesligaEstrela > ET (TIME)
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MOELLER

X]

Categony:
Shape —Warnables
Text
Like width Irvizible:
Color

kation abzolute
b ation relative

Yariables
[ npLt
Text for Tooltip

T extdisplay:

Change calar; I

o]

Cancel |

IF'LI:_P'H G.TempoDesligaEstrela.ET

e Nossa tela de visualizagdo esta pronta:

Fartida motar Parada Motor

Bomba de Vacuo Bomba de Vacuo

e Vamos colocar o programa mais uma vez em funcionamento
e Certifique-se que 0 XSOFT esteja em modo de simulagdo (Online = Simulation Mode...)
e  Clique no menu Online 2 Login e logo em seguida Online 2 RUN.

Partida Motar Parada Motor

Tempo T#0ms

e Clique no botdo Partida Motor. Observe que se vocé€ segurar o0 mouse sobre um objeto ele ira exibir o texto digitado

em Tooltip.

Partida Motor Farada Motor

igar & Bomba de vacug—————

Termpo T#1s150ms

k

Tempo c\iecorrido

/

Too/ltio

Bomba de Vacuo Bomba de Wacuo Bomba de Yacuo

Sistema parado

- - Bornba de Yacuo

Sistema partindo

e Apos 3 segundos a contatora estrela desliga. E ap6s mais um segundo a contatora tridngulo é acionada.

Partida Maotaor Parada Motor

Tempo T#3s0ms

- Bomba de Yacuo -

Motor em regime normal.
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TRABALHANDO COM BREAK POINTS E CONTROLADORES DE CICLO

e Break Points sdo paradas criadas em nosso programa para nos auxiliar nas etapas de testes.
e Coloque o programa em LOGIN no modo de simulagdo, mas ndo coloque o programa em RUN.

ContatorPrincipal
|

Partidahotor Faradahotor ContatorPrincipal
| {3
— | {lt ()

TempoDesligaEstrela
ContatorPrincipal TOMN

| {4
—I I I Q {}
TH#IEAPT ET—

Contatorfuxiliar

ContatorPrincipal ContatorAuxiliar ContatorEstrela

| | L ()

TempoLigaTriangulo
ContatorPrincipal TempoDesligaEstrela.q TOM ContatorTriangulo

|1 I I
1 | 11 N e o {)
T#154PT ET—

e Do lado esquerdo podemos ver a numeragéo das linhas logicas.
e  Clique com 0 mouse sobre o numero 2 € 0 numero 4.

PartidamMator Paradabotor ContatarPrincipal
1 | W P
|| III v/

TempoDesligaEstrela
ContatorPrincipal ToM

[ 1 P
1 | I e @ {)
T#35dPT ET—

ContatorAuxiliar

ContatorPrincipal ContatorAuxiliar ContatorEstrela

— | Ll {}

TempoLigaTriangulo
ContatorPrincipal TempoDesligaEstrela.c TOM ContatorTriangulo

[ |1 PR
— | 11 IN @ i}
T sdPT ET—

e Acabamos de criar nas logicas 2 e 4 break points. A cor azul claro indica onde estdo os break points.

e Quando selecionarmos RUN, o programa ira rodar até chegar em um break point, entdo ele ird ficar parado neste
ponto até darmos o comando RUN novamente.

e  Vano menu Online = RUN, ou pressione F5.
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Partidahotar FParadahotar ContatorPrincipal
1 {0
— | {lt {}

ContatorPrincipal

TempoDesligaEstrela
ContatorPrincipal ToN Contatarauxiliar

I [
1 | IN e Q {)
T#354PT ET—

ContatorPrincipal ContatorAuxiliar ContatorEstrela

— | L { )

TempoLigaTriangulo
ContatorPrincipal TempoDesligaEstrela.Q ToM ContatorTriangulo

I I [
1 | 11 N 9 Q {)
T#1594PT ET—

e O programa roda e ir4 parar na linha 2. Esta assume a cor vermelha para indicar onde o programa parou
e A linha 2 e a trés s6 serdo executadas quando pressionarmos RUN novamente.

Partidamotor Paradantotor ContatorPrincipal
1 | W i P
|| III vV

ContatorPrincipal

— |

TempoDeslinaEstrela
ContatorPrincipal TOM ContatorAuxiliar

| {3
— | S W g
T#IEHPT ET—

ContatorPrincipal Contatortugiliar ContatorEstrela
1 | W P
|| III v/

TempoLigaTriangulo
ContatorPrincipal TempoDesligaEstrela.( TOM ContatorTriangulo

|1 [
1 | I IN e @ [
T 5PT ET—

O programa ira rodar até encontrar outro break point. No nosso caso o proximo break point esta na linha 4.

O programa s6 executard a linha 4, 5 e 1 se pressionarmos RUN novamente.

O programa volta a parar na linha 2.

Para desativar o break point clique uma vez com o botao esquerdo do mouse sobre a linha2 e 4.

Podemos ainda trabalhar com um controlador de ciclo, ou seja, um comando que induz o CLP a executar um ciclo de
cada vez.

e Entre em Menu Online = Single Cycle ou pressione CTRL + F5. Com isto o programa ira rodar uma vez e logo em
seguida entrara em stop.
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e Qutra ferramenta ¢ o Step. Este comando faz com que o CLP execute uma linha l6gica de cada vez.
e  Crie um break point na linha 1 do programa e entre no Menu Online = Run ou pressione F3.

Fartidamotor Faradamotor ContatorPrincipal
_| | T FERY
| III LY

ContatorPrincipal

TempoDesligaEstrela
ContatorPrincipal TOMN ContatorAuxiliar

| {3
— | IN @ L}
T#354PT ET—

ContatorPrincipal ContatorAuxiliar ContatorEstrela
] | | {3
11 III LY

TempoLigaTriangulo
CuontatorPrincipal TempoDesligaEstrela.q TOM ContatorTriangulo

[ 1 |1 P
1 | I N e @ {)
T#154PT ET—

e  Entre no menu Online = Step in, ou pressione F8.
e Repare que apesar de ndo termos criado um break point na linha dois, esta fica vermelha.

0001
Partidamotor Paradantotor ContatorPrincipal
1 | W P
|| III vV

ContatorPrincipal

—

TempoDeslinaEstrela
ContatorPrincipal TOM ContatorAuxiliar

| {3
— | S W g
T#IEHPT ET—

ContatorPrincipal Contatortugiliar ContatorEstrela
1 | W P
|| III v/

TempoLigaTriangulo
ContatorPrincipal TempoDesligaEstrela.( TOM ContatorTriangulo

|1 [ 1 [
1 | I IN e @ {)
T 5PT ET—

e  Se pressionarmos F8 ou dermos mais uma vez o comando Step In, a linha 2 sera executada e o programa ira parar na
linha3.

e (Caso pressionemos F5 ou executemos o comando RUN, o programa ird executar as linhas logicas deste ponto em
diante e ira parar assim que encontrar um break point.
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MOELLER

CAPITULO 7

TRANSFERINDO O PROGRAMA

e Coloque o cabo no CLP, certifique-se de que ele estd com a bateria.
e No menu Online, certifique-se que o Xsoft ndo estd em modo de simulagdo.
e  Entre agora em On line - Communication Parameters

Communication Parameters E2
— Chahnels

B | | |
Mame | Walue | Comnment | ﬂl
MNew ... |
Gateway ... |
\ Update |

/ \

[ \

Tipo de conexdo Configuragdo da
(TCP/IP ou LOCAL) conexao

e  Se estiver utilizando uma CPU XC100, entdo o tipo de conexdo devera estar local.
e Se for CPU modelo XC200 ou XC600, entdo o tipo de conexao serda TCP/IP.
e Para deixar a conexdo no modo local, clique em gateway e configure desta forma:

Communication Parameters: Gateway E2
Cammestn :

Address: e

localhozt j
Basswan: I
o I‘I 210

I

e Clique agora na op¢do New...
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Communication Parameterz: New Channel

E
gKl
_ Lered |

Device Cancel
Marne | Info |
Serial [A5232] 35 Senal RS232 driver

Serial [Modem) 35 Modem driver
CaMopen DSP302 35 CAMapen DSPI02 driver

e Selecione a opgdo Serial (RS232) 3S Serial RS232 driver.

Gateway ...

Commumication Parameters Ed |
— Channels
]
= Local [geial (RS232) |
% | ocal c |
I ame | W alle | Comment | ﬂl
Port COM1
Baudrate 38400
Parity Mo Porta serial Mew .
Stap bitz 1
Matorola bytear... Mo Baud rate Bemove |

Update

e  Clique com o botdo da esquerda sobre 0 COMI1, ele ira ficar cinza e a cada dois cliques ele mudara a configurag@o,
faga isso até achar sua configuracao.
e Clique agora no Baud Rate, utilizando o mesmo principio, até chegar na velocidade de 57600.
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Communication Parameters E

— Channels

& Local [Serisl [RS232) |

LCancel
M ame | Walue | Comment |
Pt COM2
Baudrate 87RO
Parity Mo
Stop bits 1
otorola bypteor... Mo Remove

Gateway ..

Update

i ft

e  Entre agora na op¢ao Online - Login
XSoft

Ma pragrar an the contrallenl Downlaad the new pragranm?

Man | Cancelar |

e Selecione a opgdo Sim.
e Logo apds o Download o CLP estara pronto para entrar em operacao.
e Tudo o que foi explicado até aqui, tanto em monitoragdo como em simulagdo ¢ valido quando se esta conectado ao
CLP.
e  Para colocar o CLP em marcha selecione Online - RUN.
ALTERACOES ON LINE
Para executar qualquer alteragdo ON LINE no CLP proceda da seguinte forma:
Entre em Online - Logout
Faga as altera¢des necessarias no software.
Entre no menu Project > Rebuild All...
Logo em seguida selecione no menu On line = Login

M

Online Change

The program haz changed! Should the changes be loaded? [OMLIME CHAMGE]

Mo | LCancel | Load all |

e Se selecionarmos Yes as alteracdes serdo feitas sem parar o processamento (ONLINE CHANGE)

e A opcdo Load all ird parar a CPU para executar a transferéncia.

e A alteragdio ONLINE s6 ndo pode ser feita em duas situagdes distintas: Alteracdes de hardware e inser¢des de novas
bibliotecas.
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MOELLER
CAPITULO 8

CONSIDERACOES FINAIS

Este manual foi criado conforme a versao mais atual do software XSOFT. A Moeller Electric se reserva ao direito de
revisar, alterar e efetuar quaisquer alteragcdes neste manual sem aviso prévio.

Leia com atencdo os manuais de programacdo, tente compreender mais blocos de fungdes através do Help do
software e através do manual.

O programa aqui apresentado ¢ apenas para efeito didatico, a Moeller Electric ndo se responsabiliza por danos que o
uso deste programa venha a causar.

Qualquer davida contate:

Moeller

Departamento de Engenharia de Aplicagdes.
Tel.: (0xx19)3765-5520

(0xx19) 3765-5521

(0xx19) 3765-5500

e-mail: suporte@moeller.com.br
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ANEXOS

IMPORTANDO BIBLIOTECAS

As bibliotecas sdo conjuntos de function Blocks que podem ser exportadas e importadas.
Para importar uma nova Biblioteca, proceda da seguinte forma:
e Selecione no menu a op¢do Window > Library Manager:

Bibliotecas
importadas

! dard.lib 7
RTCLib.lib 4.9.02 10:06:00
Counter.dib 9.1.03 13:12:26

FUNCTION_BLOCK TOMN
(* Timer on delay.

AR_IMNPLUT

{23 Stiing Functions

----- COMCAT [FUM]
----- DELETE [FLN)
----- FIND [FUN)

----- INSERT [FLN)
----- LEFT [FUN)

----- LEN [FUM)

----- MID [FLIN)

----- REPLACE [FUN)
----- RIGHT [FUM)
B3 Timer

----- RTC [FB)

----- TOF [FB]

----- TP [FB)

----- TOM [FE)

" Visua...

IN: BOOL; (* starts tirmer with rising edge, resets t
PT. TIME; {*time topass, befare @ is set™)

(* internal variakle *)
StartTime: TIME; (% internal variakile *)

Protétipo do Bloco
selecionado.

/

Qis TRUE, PT milliseconds atter IM had a rising edogg

*is TRUE, FT seconds after IM had a risihig edge ®)

time =)

MOELLER

erwith falling edge *

END_WAR
VAR_OUTPUT
G BOOL,
4| | LI ET. TIME; (*elapsed
EMD_WAR
N POUs IS |
-3 Bistable Function Blocks M: BOOL;
""" A5 [FE) END_VAR
----- SEM& [FE) -
----- SR (FB)
-3 Counter
----- CTD [FB) KN
----- CTU [FB)
----- CTUD [FE)

Organizador do
Library manager

e Para importar uma nova biblioteca clicamos com o botdo da direita do mouse sobre a area de bibliotecas importadas.
e  Assim que a caixa de didlogos abrir selecionamos a op¢do Additional Library.
e E escolhemos o arquivo .LIB que desejamos importar neste projeto.
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VARIAVEIS

As variaveis geralmente sdo declaradas antes de serem usadas. A declaracdo consiste do nome da variavel e o tipo de
dado. Dependendo do tipo de dado atribuido a uma variavel existe uma faixa de valores admissiveis. Por exemplo: o tipo de
dado SINT possui 8 bits, ¢ pode assumir valores entre -128 a 127, ja o tipo USINT que também possui 8 bits, pode assumir
valores entre 0 e 255.

Os tipos de dados elementares definidos pela IEC1131-3 sdo:

Binary um ou varios bits em grupo de operagdes binaria.
Integer todos os nimeros inteiros.

Real nimeros com ponto flutuante

String conjunto de caracteres alfanuméricos.
Date/Time datas, hora do dia e data e hora.

Junto com o tamanho da varidvel e sua faixa de valores, os tipos de dados também decidem que tipos de operagao sao
permitidas para estas variaveis, por exemplo uma variavel do tipo Integer s6 pode ser usado em fungdes aritméticas, ja uma
variavel do tipo Binary s6 pode ser usada em fungdes logicas.

Isto soluciona o problema do operador que testa diferentes tipos de dados na aplicag@o. Freqiientes erros podem ser
facilmente reconhecidos com uma rapida observacdo do programa. Temos os seguintes tipos de dados descritos a seguir:

Palavra Chave Tipo de dado. bits
BOOL nimero booleano; aceita valores de 0 ou 1. 1
SINT inteiro curto; com faixa de valores de -128 a 127. 8
INT inteiro; com faixa de valores de -32768 a 32767. 16
USINT inteiro curto sem sinal; com faixa de valores de 0 255. 8
UINT inteiro sem sinal; com faixa de valores de 0 a 65535. 16
DINT inteiro duplo com sinal com faixa de —2°*' a 2°' -1 32
UDINT inteiro duplo sem sinal com faixa de 0 a 2% -1 32
LINT inteiro longo com sinal com faixa de 2% a 2% —1 64
ULINT inteiro longo sem sinal com faixa de 0 a 2%* -1 64
REAL ponto flutuante com faixa de +/- 10 * 32
LREAL ponto flutuante com faixa de +/- 10 /=% 64
TIME duragdo -
DATE data. -
STRING Conjunto de caracteres com tamanho variavel. variavel
BYTE seqiiéncia de 8 bits. 8
WORD seqiiéncia de 16 bits. 16

(*Alguns tipos de variaveis ndo sao suportados por algumas CPUs*)

Ou seja, se desejamos fazer logicas Booleanas devemos utilizar variaveis do tipo: BOOL, Byte ou Word; se for
necessario efetuar fungdes aritméticas utilizamos as variaveis do tipo: INT, SINT,USINT, etc.
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